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What Does PopMan do?
What Does PopMan do?

PopMan is a way of launching programs using a popup menu, rather than 
an icon-based program such as Program Manager, for example.    PopMan 
can be invoked in various ways once it is executed, and stays in the 
"background" until needed.    It is meant to be a readily-accessible menu 
system which can be used at any time, without the need to minimize your
active application and restore another.    For example, it may be invoked 
from a mouse click or a hotkey.    PopMan works well in conjunction with 
other shell programs, and can itself be used as a Windows shell.



Previously Applied Bitmaps
Click on the drop-down list below the bitmap file list to see up to the last 
ten bitmaps applied using the wallpaper changer.



Exit Options
This menu item leads to options for exiting PopMan, exiting Windows,  
restarting Windows, or rebooting your computer.



About PopMan
PopMan 1.1 is shareware.    You may evaluate it for free for up to 30 days.   
Registration is $15 U.S. or $20 Canadian.    See the Registration Form for 
licencing agreement & registration details..

PopMan 1.1 is © 1995 Carl Mellesmoen.    All rights reserved.



Configure
This option leads to either the PopMan setup, the menu setup, or the 
Wallpaper Changer utility.



Help - Contents
Clicking on 'Help - Contents' or smacking your 'F1' key when a PopMan 
dialog box is acitve will invoke the Windows help engine (winhelp.exe) and
open this help file.    Who'da thunkit?



Help - About
Opens a dialog box that displays information about the program.



'Run' Dialog
Run...Browse

The "Run Program" dialog is invoked from the "Run -- Browse..." menu 
item.    From here, command lines can be selected, and programs 
executed by double-clicking on the file name within the file list, or by 
pressing the "OK" button after a file is selected.

A second submenu from the "Run" menu is the "History" menu. 

Modify/Add Dialog (Under Menu Editor)
The dialog box for editing menu items (modifying existing ones or adding 
new ones) is the same as the "Run" dialog except for two other items that 
are present.

· Menu Title
· Working Directory



Task List
Selecting this item from the PopMan menu will open the program you 
have configured as your Windows "task manager".    This is the program 
that also appears when you double-click on your desktop, or when you 
press "CTRL-Esc".



PopMan Menu Types
PopMan Menu Types
There are four types of PopMan menus that you can configure for your 
own use, and one menu that is non-configurable (the actual menu that 
PopMan uses as its basis).

The four types are:

· Quick Menu - PM
· Utility Menu - PM
· Group Menu - PM
· Individual programs under each group in the Group Menu.

Changing Menu Item Location:
Each of the menus can be sorted alphabetically, as well as by manually 
moving their items up & down in the menu.    The menu must be then 
saved to make the changes take effect.



Moving Menu Items
The items within each menu may be individually moved up & down in the 
menu hierarchy by selecting them & pressing the large "up arrow" and 
"down arrow" buttons to the right of the menu item list, in the Menu 
Editor.



Quick Menu - PM
This is the "main" menu that appears atop all of the other menu items in 
the main PopMan menu.    It is the easiest menu to access, and is useful to
keep a "short list" of the programs that you use the most often.



Utility Menu - PM
The menu containing utilities that you specify, which are one level "below"
the main PopMan menu.    These can be any programs, but accessing 
them requires an extra click, when compared to the Quick Menu, so they 
should be programs that you use less often, but nevertheless would like to
have handy (for example, "SysEdit", "Notepad," or "Control Panel").



Group Menu - PM
The menu containing all of the group titles, which are themselves also 
menus.    This is analagous to Program Manager groups, which themselves 
have other programs inside each group.    In fact, the group menu can be 
created by loading your present Program Manager groups.



Group 'Sub'-Menus
The menus showing up under the "Group" menu item as submenus, 
containing programs which (if you wish!) logically belong to each group; 
each group is listed in the "Edit" drop-down menu under its given name 
(this differs from the other three menu types, which appear with the 
names followed by " - PM".



Command Line
This is the path & filename of the program (or associated file) to be 
executed.



Working Directory
This is the directory that the selected program will default to (for example,
when opening files, it will display this directory automatically).    Blank this
out if you don't want to have a default directory for the program.    The 
directory of the selected progam is the automatically selected default (it is
automatically placed there when a file is first selected).



Menu Title
The title of the program as it will appear on the menu being configured.    
PopMan automatically uses the first part of the file name (without the 
extension) when a file is selected.    Edit any changes you want to make.



Current Drive
The drive currently selected to search for an executable file or file 
associated with a particular program.



Current Directory
The directory currently selected to search for an executable file or file 
associated with a particular program.



File List
The list of files in the current directory which fit the current file mask.    
Double-clicking on a file name here will select the file and close the dialog
box.



File Mask
The "wildcard" pattern (using a combination of literal characters, and the 
wildcard symbols "*" and "?" that filters out files not matching the pattern.
You can manually type in a wildcard pattern, or choose from the drop-
down list.



File Mask List
This is a drop-down list from which you can select a pre-defined file mask. 
You can also manually enter a wildcard pattern as a file mask.



Wallpaper Changer
The wallpaper changer is invoked by selecting "Configure-Wallpaper" from
the PopMan menu.

Wallpaper Options:

You can select one of the following ways to display Windows wallpaper:
· Center
· Tile
· None

Actions:
· View
· Apply
· Exit



Apply
When this button is pressed, the currently selected bitmap will be used as 
Windows wallpaper, unless the None option is chosen.



Bitmaps Available
This list contains all bitmap (bmp) files in your Windows directory, which 
can be used as wallpaper.



View
When this box is checked, the currently selected bitmap will be displayed 
in the "thumbnail" window.    To view the bitmap actual size, double-click 
on the image in the window (this may be toggled back to the "thumbnail" 
size by double-clicking on the image a second time).



Exit
Exits the dialog box.



Bitmap Size
Displays the size of the selected bitmap, in bytes.    Bigger bitmaps reduce
the amount of free memory.



Free Memory
Display of the amount of free memory, in kilobytes.    This is updated 
whenever a new bitmap is applied.



None
When the "none" option button is chosen, any bitmap that is in use as 
wallpaper will be removed from the desktop, when the "apply" button is 
pressed.



Center
When this option button is selected, any wallpaper will be centered on the
Windows desktop when it is applied.



Tile
When this option button is selected, any wallpaper will be tiled on the 
Windows desktop when it is applied.



Reload Program Manager Groups
When you have Program Manager running as the shell, to get PopMan to 
load your Program Manager groups in order to copy them into the PopMan
popup menu, just press the button "Reload ProgMan Groups" in the menu 
editing dialog box (this button will not be present if a different program is 
the shell, so, in order to use it,you must first make Program Manager your 
shell), and your current ProgMan groups will be loaded into the PopMan 
popup menu.    A new menu item "Groups" will be added, and the ProgMan
groups will appear as a submenu of that item.    Once the groups are 
loaded, Program Manager does not have to be the active shell in order for 
PopMan to run, using these groups, or when editing the groups under 
PopMan's menu editor (you can change back to another shell once you 
have loaded the groups under ProgMan, or simply create the groups, of 
your own design, one by one on your own using the menu editor). 
 
The groups may be reloaded at any time, when Program Manager is the 
shell in effect.    The reloading will re-align the groups to the latest 
ProgMan configuration.    Any prior changes done under PopMan to the 
groups will be lost. 

Once the groups have been loaded at least once, each item may be 
edited or modified, or items may be removed from the groups, although at
present, the groups themselves may not be removed.    Any empty groups 
will have "|" listed as a disabled ("grayed out") item.



Editing PopMan Menus

This editor can be used to make changes to all the PopMan    Menu Types.   
No items appear in the list when the dialog opens. To choose a menu, you 
need to select from the "Edit" drop-down menu, which will contain a list of
all possible editable menus. 

· Add
· Modify
· Remove
· Sort
· Save
· Exit
· Move Up/Down
· Reload ProgMan Groups



Add Item
Pressing this button will allow you to select an executable file (or a data 
file associated with a particular program) from the "Add Menu Item"dialog 
box that appears.    Clicking once on a file name from the file list will place 
that file's path & name in the "command line" area, and the first part of 
the file name in the "Menu Title" area.    Both of these may be manually 
altered before exiting this dialog box.    Double-clicking on a file name 
does the above actions & also exits the dialog box.



Modify Item
An already existing menu item can be changed by selecting this option, 
which opens the "Modify Menu Item" dialog box (a menu item must first 
be selected in order to access this feature).    Options that can be modified
include the menu title, the working directory, and the actual executable 
file or data file associated with a program.    Clicking once on a file name 
will change the file path to the selected file.    Double-clicking on the file 
name will change to the selected file and also close the "modify" dialog 
box.



Remove Item
Pressing this button removes the currently selected menu item from the 
current menu being edited.



Sorting Menus
The "Sort" button in the Menu Editor will invoke an automatic sorting 
routine, which sorts the menu items alphabetically, and does nothing if 
the items are already sorted.



Saving Menus
This button must be pressed to save the manually-done changes to the 
menus.    Note that choosing the "Reload Progman Groups" button is the 
exception to this rule; choosing it is an irrevocable process (unless you 
first make a backup copy of your "PopMan.INI" file).



PopMan Setup
Setup Options

· Launch Methods
This option determines how PopMan will load.    Note that PopMan 

execution must first be started    as with any other Windows-based 
program.    Once started, it will wait for the designated action to 
occur, either:

· Middle Mouse Button
· Right Mouse Button
· CTRL+Key
· Left & Right Mouse Buttons
· Icon Launching

If a particular method conflicts with other software you are running (eg. 
Norton Desktop for Windows), you might want to choose the "Left & 
Right Mouse Button" launch option.

· Menu Alignment
· Center
· Right
· Left
· Position on Desktop

· Confirmation

· Miscellaneous:

· Right-Button Menu Access
· Safe Launch
· History List
· View Wallpaper Automatically



Confirmation

You can configure whether PopMan will ask you to confirm the action of 
exiting PopMan, exiting Windows,  restarting Windows, or rebooting your 
computer.    If the corresponding box is checked, and the setup is saved, 
PopMan will give you a "Are you sure...Yes/No" choice when you choose 
one of the exit options.



This method allows you to access the PopMan menu by double-clicking 
the PopMan icon, in the same way as you would normally activate a 
minimized (or "iconized") program.



Middle Mouse Button

When this is selected as the launch method, the popup menu will appear 
when the middle mouse button is clicked (if the 'safe launch' option is 
enabled, the menu will wait for the button to be released as well).



Right Mouse Button

When this is selected as the launch method, the popup menu will appear 
when the right mouse button is clicked (if the 'safe launch' option is 
enabled, the menu will wait for the button to be released as well).    If 
using the right mouse button interferes with using another Windows 
program (eg. Norton Desktop uses the right mouse button for multiple file 
selections & other things), you may want to experiment with using 
different combinations of the 'safe launch' and the "Position on Desktop" 
feature with the right button.    



Left & Right Mouse Button

When this is selected as the launch method, the popup menu will appear 
when both the left and right mouse buttons are clicked (if the 'safe launch'
option is enabled, the menu will wait for both    buttons to be released as 
well).



What to do if PopMan Doesn't Launch

If it happens that PopMan is running, but you are unable to launch the 
popup menu, you may have to shut down PopMan by exiting Windows, 
and then edit the PopMan.INI file (eg. using DOS "Edit" or some other text 
editor, or "Notepad" under Windows, if PopMan is not set up to 
automatically load with Windows). You will need to either totally remove 
the line under [Settings] that starts with "LaunchTrigger" (this will cause 
the PopMan setup to appear the next time PopMan is executed, when you 
can choose another method), or edit it to say "Right", "Both", or "Middle", 
or edit the "Key" entry under [Settings] (if it is the CTRL-key method that 
is causing the problem -- but the above methods will also work in this 
case)to another key value that is (hopefully!) not already associated with 
some other program.    Note that doing any of these things will not 
necessarily work if they are done while PopMan is running.



CTRL+key Method

This option allows for invoking PopMan by using a "hotkey" that you 
specify.    If the option button for this method is selected, you will need to 
supply a key to be pressed along with the "CTRL" key in order to invoke 
PopMan. Be careful not to use a "Hotkey" associated with another 
Windows program or function.    If you do, PopMan may be "blocked out" 
by that program or function, and you will not be able to invoke it.    In that 
case, you will have to remove the current launch method.



Menu Alignment - Center
This feature will cause the popup menu to be horizontally centered around
the mouse cursor (when possible - Windows will put the menu in a 
location such that it will fit within the screen, so if your mouse cursor is 
near the edge of the screen, the menu will be placed closer to the center 
in order to be accommodated).    



Menu Alignment - Right
If this alignment is selected, the menu will appear to the right of the 
mouse cursor (when possible).    This is the default, which was used in 
previous versions of PopMan.



Menu Alignment - Left
If this alignment is selected, the menu will appear to the left of the mouse 
cursor (when possible).



Position on Desktop
Menu Alignment - Position on Desktop

This option allows you to specify screen coordinates for the location of 
the top left corner of the popup menu. You specify the 'x' coordinate 
in the 'Horizontal Pos.' box, and the 'y' coordinate in the 'Vertical Pos.'
box.    There are two things to note about these coordinates:

 
· 1) They are situated relative to an invisible form that has a "title bar",

so using the default value of '0' for the vertical position will cause the 
popup menu to appear below the top edge of the screen, at the same
height as a normal drop-down menu.    You may want to try to leave 
the vertical position at 0, and find a suitable horizontal position so 
that the PopMan menu appears next to your other application menus.

· 2) If you want to position the popup menu at the top edge of the 
screen, you will need to experiment with the vertical position, using a 
negative value.    Also, if you wish to place the popup menu along any
other screen edge, you will need to experiment to see what settings 
will acheive the desired result.    For example, using a horizontal value
which is a few units less than the screen width in pixels will align the 
menu along the right edge of the screen, and it may take some trial 
and error to determine the desired value (on my computer, a 
horizontal value of 1021 under 1024 x 768, or a value of 797 under 
800 x 600 does the trick).



Selecting this option will cause PopMan to stop running.



Selecting this option will cause Windows to shut down, after it checks 
running programs to see if they require files being saved, etc.



This option automatically exits Windows & restarts it.



Selecting this option will first exit Windows & then reboot your computer.



Toggles the View Wallpaper option for the Wallpaper Changer utility.



Right-Button Menu Access
When this option is checked, popup menu items can be accessed with 
either the right or left mouse buttons.    If this feature is enabled along 
with the "Right mouse button" launching method and the "'Safe' Launch" 
feature disabled, it is possible to use PopMan to launch a program without 
releasing & pressing the right mouse button a second time.    (Warning:    
This particular configuration (Right or Left & Right mouse button 
launching, right mouse button access, and 'Safe' launch disabled) can be 
"dangerous" unless you are very adept at manipulating your mouse, and 
may take some practice to avoid launching a program inadvertently!) 



History List
A number of previously used command lines are maintained in a "history" 
list of up to 32 of those launched by PopMan, with the latest listed at the 
top, and the next most previously launched item in the next position, etc.  
This list can be used to launch the programs again, and can be quite 
useful, since you are more likely to use a program that you have used 
recently than one that you haven't used in quite a while.    You can enter 
any value for the number of items to keep in the list under PopMan Setup, 
but PopMan will restrict the range to a value between 0 and 32 (default is 
16 if the option has not yet been configured).



When this feature is enabled (default), the PopMan menu will not appear 
until the Right, Middle, or Left & Right mouse buttons are clicked and 
released.    When disabled, the PopMan menu will appear as soon as the 
Right/Middle/Right & Left mouse buttons are clicked (i.e., before they are 
released).    This makes for a more responsive launching of the menu, but 
some may find it trickier to work with.    PopMan 1.0 had the 'Safe' launch 
method only.



Registration Form
PopMan Registration Form

PopMan 1.1 (c) 1995, Carl Mellesmoen, all rights reserved.

 To print out this form, choose "File...Print Topic" from the help menu. 
Licencing Agreement
PopMan is supplied on an "as is" basis and the author is not liable for any 
problems encountered while using it, either by direct or indirect cause.    
Users of this software, registered or    not, assume all risk associated with 
its use.    Anyone may use this software for free without registering it for 
30 days, and 30 days only.    After this period, they must either send the    
registration fee to the author (as outlined below), along with their name 
and mailing address, or discontinue their use of the PopMan software.    
Registration entitles the user to use the PopMan software on one or more 
computers (one at a time), or for multiple users to use the software on a 
single workstation.    Any additional use requires additional registration(s). 
The PopMan software may be freely distributed in its original form, but 
may not be in any way altered or reverse-engineered. 

The licencing agreement is to be governed by the laws of the province of 
Saskatchewan, Canada.

Registration of PopMan implies acceptance of the licencing conditions as 
specified above.    Registered users will be sent a letter or electronic mail 
message containing their validation number upon receipt of the 
registration fee by the author.

Please print out this form by choosing "File...Print Topic", or print out the 
form "PopReg.wri" or "PopReg.txt" as supplied in the archive in which 
PopMan is distributed. Fill in the information as requested, and send it, 
along with a cheque or money order for $20 in Canadian funds or $15 in 
U.S. funds, to this address:

Carl Mellesmoen
238 - 4th St. East
Saskatoon, SK, Canada
S7H 1J1

Internet e-mail for purposes other than registration may be sent to: 
cgm133@cs.usask.ca

PopMan Registration Form



Name:
___________________________________________________________

Mailing Address:

___________________________________________________________

___________________________________________________________

City:

___________________________________________________________

Postal/Zip Code: ______________________________

Country:                  ______________________________

TELEPHONE:              __________________________

You may not have any or all of the following types of addresses, but if you 
do, please include them so that your registration password may be sent 
electronically.    This will make it more convenient to send you your 
password, and will also mean that you will receive it much more quickly.    
If an electronic message is not possible, or does not work, your 
registration will be sent by regular ("snail") mail.

Internet e-mail address:

_______________________________________________

FIDONet e-mail address:

_______________________________________________

Compuserve e-mail address:

_______________________________________________

How did you hear about, and/or where did you obtain PopMan from?

________________________________________________________________

________________________________________________________________

Please add any additional comments below:








